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Your MYOB company file stores lots of information about the key areas of your business, 
including your customers, suppliers, employees, inventory and jobs. The more detail and 
data you enter, the more information will be available to help you make better business 
decisions.

With your MYOB software’s reports you can analyse your business from different 
perspectives, learn more about your customers, maintain the integrity of your business 
information, and take care of your tax obligations.

This guide will show you how to make the most of the standard reports found in your MYOB 
software and how to get the information you need in the format you want.
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There are two easy ways to access the many reports that are available in your MYOB software:
1. To access the Index to Reports window, go to the Reports menu and choose Index to 

Reports.

 
2. To access the reports that are relevant to the active command centre, click the Reports 

button in the bottom-right corner. If you want to choose a different report category, click the 
adjacent down-arrow and make your selection.

 

 

 

Quick Tip: Getting faster access to your favourite reports

If you use particular reports more often than others, you can choose to list them in the Reports 
menu. This lets you access the reports you want with just one click.

To list a report in the Reports menu
1. Go to the Reports menu and choose Index to Reports.
2. Highlight a report and then click Customise.
3. In the Report Customisation window, click the Finishing tab.
4. Mark the Add to Reports Menu checkbox. 

5. Click Display to view the report and to add it to the Reports menu.  

!  This feature is not available for MYOB FirstEdge and MYOB BusinessBasics.

Accessing reports
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Click a report name in this  
list to select it.

Click View Sample to read  
more information about  
the selected report or to  
view a sample. 

 

Click the Custom tab to display 
a list of reports that you have 
customised and saved as new 
reports.

Click Display to display 
the selected report without 
customising it. 

A look at the Index to Reports window

Click Customise to edit the appearance or content of the 
selected report before viewing it. Alternatively you can 
double-click the report name.

Click Print if you want to print the selected report or click Send To if you 
want to view the report in Microsoft® Excel, save it as a PDF or HTML file, 
or to email or fax it.

Click the report category tabs to locate the report you need. Most reports are categorised into the same 
functions that appear on your Command Centre i.e. Accounts, Banking, Sales, Purchases etc.
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Once you have located and selected the report you want to use, you can choose to view/print/
export the report with its default settings, or you can customise the report beforehand. 

In this section, we’ll assume that you’re happy to use the default report options and formatting. 
In the following sections we’ll look at how you can customise the reports to your specific 
requirements.

What can you do with reports?

Print Store printed copies of the key reports for your records.

Display on screen Preview the reports before printing them, or easily drill-down 
into the report detail.

Save as files Open report information using another program, or save copies 
of the reports on disk for your records.

Send by email or fax Send reports to your accountant and others for review.

View using Microsoft 
Excel

Edit reports, perform more advanced analyses, and create 
graphs.

 
Printing reports
To print a report, go to the Index to Reports window, select the report you would like to print 
and then click Print. 

Quick tip: Print reports in landscape orientation

Some reports are best printed in landscape orientation due to the number of columns they 
include. You can check which orientation is best for the report you want to print by displaying 
the report and selecting Print Preview from the View drop-down list.  

If the report does not fit, go to the File menu, choose Print Setup, and change the page 
orientation. Click OK and then click Redisplay in the Report Display window to see how the 
report will print in landscape orientation.

!   The View drop-down list is not available in MYOB FirstEdge or MYOB BusinessBasics, and 
your reports are always displayed in the Print Preview layout. If the report does not fit in the 
current orientation, go to the File menu, choose Print Setup, and change the page orientation. 
Click OK and then close and redisplay the report to preview it.

Displaying reports on screen
To display a report, go to the Index to Reports window, select the report you would like to view 
and then click Display. 

To preview how the report will print, select Print Preview from the View drop-down list, 
otherwise ensure that Screen Report is selected.

With most reports you can drill down into the details behind a record, transaction or total shown 
on the report, directly from the Report Display window. 

Displaying, printing and exporting reports
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To drill down into a report
1. Move your mouse cursor over the transaction, record or amount that you want to analyse in 

more detail. If the mouse cursor changes to a magnifying glass, you are able to drill down to 
the detail.

2. Click your left mouse button and either the actual record, original transaction or a window 
showing what the total consists of will appear. 

Saving reports as files on disk
When you save a report as a file, you have the flexibility to do whatever you want with the 
report – you can further modify it using a spreadsheet program, move it to another computer for 
printing or simply save it for your permanent records.

To save a report as a file, go to the Index to Reports window, select the report you would like to 
view and then click Send To. 

You now have the option of saving the report in the following file formats:

PDF Select this option when you want to retain the formatting of 
the report. Adobe® Reader® is required to view a report that has 
been saved as a PDF file.  Adobe Reader is a free application and 
is available on your MYOB software’s installation CD. 

HTML Select this option when you want to save a report that can be 
viewed using an internet browser such as Microsoft Internet 
Explorer.

Tab-Delimited Text File Select this option when you want to open the report using 
spreadsheet software. Fields in the report are separated by tab 
characters.

Comma-Separated Text 
File

This option can also be selected when you want to open the 
report using spreadsheet software. Fields in the report are 
separated by commas.  

Simple Text Select this option when you want to save a report in plain text 
format that resembles as closely as possible the printed layout 
of the report. This file can be opened using programs such as 
Notepad, Microsoft Word or TextEdit. 

Emailing reports*
If you want to email a report, ensure that QuickTime Player version 5 or later has been installed on 
your computer. QuickTime Player is a free application and is available on your MYOB software’s 
installation CD.  

To email a report
1. Go to the Index to Reports window and select the report you would like to email.
2. Click Send To and choose E-mail. 
3. If a card for the recipient has been created in your company file, select their card using the 

Displaying, printing and exporting reports
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Name field. If they have multiple email addresses, you can select which address to use by 
clicking the E-mail Address drop-down arrow.  
If the recipient does not have a card in your company file, simply type their email address in 
the E-mail Address field. 

4. Enter the email subject and any comments you want to include with the report and then click 
Send. The email will be sent to your default email program’s Outbox. 

5. Send the email and report from your email program as you normally would.

!   If you are using MYOB FirstEdge or MYOB BusinessBasics the recipient’s email address will 
need to be entered directly into the Email Address field as it is not possible to select a card using 
the E-mail Information window.

Faxing reports*
If your computer has fax software installed, you can send reports via fax directly from your MYOB 
software.  

To fax a report
1. Go to the Index to Reports window and select the report you would like to fax.
2. Click Send To and choose Fax. Your fax program’s dialogue box will appear.
3. Use the fax program to send the report as a fax.

Viewing reports in Microsoft Excel*
If you want to analyse your reports in further detail or create graphs, you can seamlessly send 
reports to Microsoft Excel via MYOB OfficeLink.

To open a report in Microsoft Excel using MYOB OfficeLink
1. Go to the Index to Reports window and select the report you would like to view in Excel.
2. Click Send To and choose Excel. The report information will be exported automatically and 

appear in an Excel worksheet.

Note that every report has a corresponding Excel template. The templates are stored in the 
Spredsht folder, which is located within your MYOB software’s installation folder. 

Also note that some reports, including the Balance Sheet and Profit & Loss reports, do not export 
formulas to Excel.

Quick tip: Speeding up the OfficeLink process

You can reduce the time it takes to export reports by starting Microsoft Excel before you send 
a report. This way, the report’s template will open quickly, without needing to also start the 
program. You should also ensure that there are no other programs running apart from your 
MYOB software and Excel.

!  While the OfficeLink procedure is not available in MYOB FirstEdge or MYOB BusinessBasics, 
you can still open and edit reports using Microsoft Excel by saving the report as a Tab-Delimited 
Text File or Comma-Separated Text File. See Saving reports as files on disk on page 6 for 
more information.

 
*These options require third party applications. For example, to email a report you will need to 
have an email program installed and operational on your computer system.

Learn how to use Microsoft Excel to analyse your 
business information
If you’re looking for greater reporting flexibility, register for the Business reports using MYOB 
accounting software and Microsoft Excel course. This half-day course shows how easy it is to 
customise and format reports to meet your business needs using your MYOB software’s 
reports and MYOB OfficeLink for Excel.

Learn how to: 
•  Customise report formats  • Add additional reporting functions 
•  Analyse data using charts  • Produce budgets 
• Use ‘what if’ functions 

To find out more about this or any other MYOB Training course, or to book online, visit  
www.myob.com.au/training/ .

Displaying, printing and exporting reports

http://www.myob.com.au/training/
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You can select the specific information that you wish 
to include in most reports. For example you can filter 
a sales report to only show activity for a particular date 
range or for a single customer.

To filter a report
1. Display the Index to Reports window.
2. Highlight the report that you wish to view.
3. Click Customise. The Report Customisation 

window appears. 
4. Use the filters that appear in the top-half of 

the Report Customisation window and in the 
Advanced Filters tab to choose what will be 
reported.  
 
!  The Advanced Filters tab is not available 

in MYOB FirstEdge or MYOB BusinessBasics.
Customisation window.

The filters that appear in the Report Customisation 
window will vary depending on the report you have 
selected.  

The screenshot pictured right shows the filters that 
available for the Customer Sales Detail report.

Filtering reports to show the information you need
Click the search icon to choose the 
customers for whom you want to  
show sales activity.

If you have categorised customers using 
custom lists, you can choose to only show 
details for customers that belong to a 
particular group.

Show sales that 
are within a certain 
date range.

Show sales that 
are within a certain 
Invoice number (ID) 
range.

Show sales whose 
invoice totals are 
within a certain 
dollar range.

Show sales in which you have specified a 
particular employee (salesperson), referral 
source, category or shipping method.

If you have allocated Identifiers to your 
customers, you can choose to only show 
customers with a specific identifier. 

Click the drop-down arrow to choose 
the types of sales to include in the 
report, for example, open or closed 
invoices, credits, orders and quotes.
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Certain additional information (for example, your company name and address or the report 
date and time) can be included or excluded from your report by making your selections in the 
Finishing tab of the Report Customisation window.

The Customer Sales Detail report allows you to set these additional options in the Finishing tab:
• Show the total number of items sold on each Item-type invoice.
• Print the sales activity for each customer on a separate page.

!   The Finishing tab is not available in MYOB FirstEdge or MYOB BusinessBasics.

Quick tip: Automatically displaying the Report Customisation window

Do you want to review the report filters every time you display or print a report? You can choose 
to make the Report Customisation window appear automatically whenever you click Display, 
Print or Send To in the Index to Reports window.  

To set this preference, go to the Setup menu and choose Preferences. Click the Reports & 
Forms tab and mark the Always Display Report Customisation Option Before Printing Reports 
checkbox. 

Notice that the Reports & Forms tab also lets you set other preferences relating to your reports, 
such as whether or not to show currency symbols.

Filtering reports to show the information you need
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You can specify which report columns you want to include in your reports using the Report Fields 
tab in the Report Customisation window.

!   Click the Design button in the Report Customisation window to display the Report Fields if 
you are using MYOB FirstEdge or MYOB BusinessBasics. 

The Report Fields window will vary, depending on the report you’re designing.  The screenshot 
below shows the report fields available for the Customer Sales Detail Report.

The Report Fields tab lists all fields that can be included in the report, and those that have already 
been selected for inclusion.

To include a field name that is not already selected mark the tick column next to its name in the 
Available Fields list. The field name will then appear in the Selected Fields list. To remove a field, 
simply clear the tick from the field name in the Available Fields list.

!   If you are using MYOB FirstEdge or MYOB BusinessBasics simply click in the Display column 
beside the report fields to include a field (an X will be shown) or exclude a field from the report. 

Note:  Report fields cannot be changed for some reports, including the Balance Sheet and Profit & 
Loss reports. 

Specifying how much detail to show
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You can change the order in which the columns/fields of a report are presented.

To rearrange report fields
1. Display the report you want to edit.
2. Select Screen Report from the View drop-down list.
3. Place the mouse cursor over a column name.  When the cursor changes to a ‘hand’ symbol, 

press the left mouse button and drag the column to its new position. Then release the mouse 
button. 

!    If you are using MYOB FirstEdge or MYOB BusinessBasics click Design in the Report 
Customisation window and then drag the field names up or down in the list to rearrange them. 

Note: Any changes that you make to the order of the report fields will not be retained unless you 
save the report as a custom report. See page 12 for information about saving a custom report.

Quick tip: Resizing columns

The “ ^ “ at the top of a column indicates that the column can be resized. To resize a column 
using the mouse, move the cursor over the “ ^ “. When the cursor changes to a double arrow, 
press the left mouse button and drag the column to the size you want. Then release the mouse 
button.

!    Report columns cannot be resized if you are using MYOB FirstEdge or MYOB BusinessBasics, 
however you can edit the report using spreadsheet software like Microsoft Excel. Click Send To in 
the Index to Reports window and choose Tab Delimited Text File or Comma-Separated Text 
File to save the report in a format that can be opened in a spreadsheet. 

Rearranging the order in which report fields are presented
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You can modify the look of your reports by selecting different font styles, sizes, colours, alignments, 
effects and page margins.

To change the look of a single report
1. Go to the Reports menu and choose Index to Reports.
2. Locate the report you want to format and highlight it.
3. Click Customise and then click Format.
4. Click the Report Line down-arrow, and select the report section you want to edit. 
5. Select your font, size and colour to apply to the selected report line. You can preview your 

changes in the right side of the window.

6. If you want to edit another report section, make your selection from the Report Line drop-
down list and repeat step 5.

7. Click OK to save your changes for that report. 

Quick tip: Restoring a report’s original format

If you have formatted a report, and then want to change its styles back to the default format, click 
Default in the Report Format window. 

To change the default look of all reports
1. Go to the File menu and choose Default Fonts.
2. Click Reports. The Report Format window appears. 
3. Make your formatting changes, as per the above procedure, and then click OK. Any changes 

made in this window will determine the formatting of all your reports except those that you 
have individually customised). 

Modifying report fonts and styles
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If you alter the design or field order of a report (as described on pages 10 and 11) and would like 
to retain those changes, you will need to save the report as a custom report.

To save a custom report
1. Design the report as you require and display the report on screen.
2. Click Save As. The Save As dialog is displayed. 
3. Enter the report name and description you want to give to this custom report.

4. Click OK and then click Close in the Report Display window. The custom report has now 
been saved. 

To view or print the custom report, click the Custom tab in the Index to Reports window. Your 
custom report will be listed here.

Saving the changes you make to reports
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If you regularly print a number of single reports at a time, say monthly financial statements, you 
may find that printing those reports as a batch can save you a lot of time. 

For example, if you create a report batch that contains all your monthly reports, you can start the 
printing process and go back to working on other important tasks with just a few clicks of the 
mouse! 

!    Report batches are not available in MYOB FirstEdge or MYOB BusinessBasics. 

To create a report batch
1. Go to the Reports 

menu and choose 
Report Batches. 
The Report Batches 
window is displayed.

2. Click New and enter 
an appropriate name 
for the batch.

3. Choose the reports 
that you want to 
add to the batch by 
clicking the name of 
each report.  A mark 
will appear next to 
each selected report, 
indicating that it is 
included in the new 
batch.  

 To remove a report 
from the batch, click 
the name a second 
time.

 Note:  Some reports, such as the Reconciliation report, can’t be added to a report batch 
because they require you to specify information each time you want to print the report.

4. Click OK. The Report Batches window is displayed again, with the name of the report batch 
listed in the scrolling list. 

To print a report batch
1. Display the Report Batches window.
2. Select the period for which you want to print the reports using the Period drop-down list. 

You can select a particular month or quarter in the current financial year or choose to print 
information for the entire year to date.  
Note that your Period selection affects different types of reports in different ways.  For 
example, if you choose January, a Job Activity report will show job activity information from 1 
January to 31 January whereas a Balance Sheet report will show balances as at 31 January.

3. Choose the report batch that you want to print and click Print.  

To add or remove reports in a report batch
1. Display the Report Batches window.
2. Highlight the name of the batch that you want to change and click Edit. The Edit Batch 

window is displayed.
3. You can now change the name of the batch and the reports that it contains.
4. Click OK to save your changes. 

To delete a report batch
1. Display the Report Batches window.
2. Highlight the name of the batch you want to delete.
3. Go to the Edit menu and choose Delete Batch. 

Printing a batch of reports



Contents     |     Previous    |     Next

Using reports to analyse your business 15 

Exit     |     Print

Every report in your MYOB software can help you run your business more efficiently and 
profitably. It’s worth spending a little time browsing the Index to Reports window to see 
what reports and customisation options are available.

In the following section we’ve highlighted a few reports that can help you make well 
informed business decisions, streamline processes, audit your business information, and 
more.

!    The reports referred to in the following section (except for the Aged Receivables 
[Detail] and Session reports) are either unavailable or vary in functionality in MYOB 
BusinessBasics and MYOB FirstEdge.

Aged Receivables [Detail] report

Need to contact your slow-paying customers?
If you’re not already keeping an eye on your debtors, make it a priority to regularly check 
who owes you money and when their payments are due. 

You can use a number of features in your MYOB software to check up on your receivables, 
including:
• The A/R tab in the To Do List window, which lists all customer payments that are due, 

sorted by due date. 
• The Analyse Receivables window (accessible from the Analysis menu in the bottom-

right of the Command Centre), which lets you easily drill-down to the sales detail.
• The Aged Receivables [Detail] report.

The Aged Receivables [Detail] report is an excellent report to use when you have identified 
the customers that need chasing up. It lists each payment that’s due and the ageing periods 
that each amount falls into. And if you want to call the customer to discuss the matter, their 
contact name and phone number is conveniently listed in the report.  

Using reports to make informed business decisions
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Using reports to make informed business decisions

To display the Aged Receivables [Detail] report
1. Go to the Reports menu and choose Index to Reports.
2. Click the Sales tab and highlight the Ageing Detail report.
3. Click Customise and select which customers you want to include in the report.
4. In the Advanced Filters tab, choose how you want the payments to be aged using the 

Ageing Method drop-down list.
5. In the Report Fields tab, you can choose to show additional details such as the due date, 

the amount paid to date, each sale’s terms, and much more.
6. In the Finishing tab, you can choose to start each customer on a new page, which is 

handy if you plan on sending the report to your customers.
7. Display the report.

Quick Tip: 

Do you have a number of customers with payments overdue for more than 60 or 90 
days? Then seriously consider chasing up those payments before they become completely 
irrecoverable. To help you out, take advantage of the MYOB Accounts Recovery Service, 
an exclusive service for MYOB Cover subscribers that lets you benefit from the experience 
and resources of debt management specialists Dun & Bradstreet. Find out more about this 
service by visiting  
www.myob.com.au/solutions/dnb.shtml .

Customer Ledger report

Is a customer querying their account or transaction history?
A great report to use when customers query their account balances, missing payments, 
or sales history is the Customer Ledger report (note that a Supplier Ledger report is also 
available). This report lists the complete history of sales, payments and credit notes for 
selected customers, with a running balance showing the day-to-day changes in their account 
balance.

To display the Customer Ledger report
1. Go to the Reports menu and choose Index to Reports.
2. Click the Sales tab and highlight the Customer Ledger report.
3. Click Customise to select the customer(s) and the date range that you want to analyse.
4. Display the report.

http://www.myob.com.au/solutions/dnb.shtml
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Using reports to make informed business decisions

Price Analysis report

When was the last time you reviewed your prices?
The cost of purchasing raw and finished goods can fluctuate over time. To avoid having these 
costs affect your bottom line, you should periodically review your selling prices. You may find that 
some prices need to increase to make selling them worthwhile, and others could be reduced or 
temporarily discounted while still maintaining your required margins.

To help you keep an eye on your costs and profit margins for each item you sell use the Price 
Analysis report. This report shows your current selling prices, the average cost of the goods 
currently on hand, and the profit margins and markup for each item. 

To display the Price Analysis report
1. Go to the Reports menu and choose Index to Reports.
2. Click the Inventory tab and highlight the Price Analysis report.
3. Click Customise to choose which items you want to include in the report and 

whether you want to display tax inclusive or exclusive prices.
4. Display the report.

Quick Tip: 

If you do wish to maintain a certain margin, markup or gross profit for your items, use 
the Set Item Prices feature in the Inventory command centre. Simply mark the items 
you want to adjust and then click the Shortcut button to specify how you want to 
adjust their prices.

Referral Source report

Where should you be spending your advertising dollars?
If you have a small marketing budget, you’ll want to know what works and what doesn’t 
to avoid wasting money on advertising that has no cut-through. Did anyone act based 
on your ad in the local paper? Do customers take up the offers in your letterbox flyers? Is 
your Yellow Pages listing being noticed?

To help you out, your MYOB software lets you record the sales referral for each sale 
you enter. This is an easy way to analyse how each dollar you spend on advertising 
and promotions translates into sales for your business. All you need to do is ask your 
customers or clients how they found out about you, and then enter their response in the 
Referral Source field when recording their invoice.

The Referral Source report can then be used to see the dollar value of sales made within a 
specified period for each referral method.
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To display the Referral Source report
1. Go to the Reports menu and choose Index to Reports.
2. Click the Sales tab and highlight the Referral Source report.
3. Click Customise to select the period you want to analyse.
4. Display the report.

Superannuation Accrual by Fund [Summary] report

Pay super to multiple funds? Here’s a report that’ll sort out how 
much to pay
If you make contributions to various super funds on behalf of your employees, working out 
how much to pay and to whom can take up a lot of your time. A simpler way to calculate fund 
contributions that need to be paid is using the Superannuation Accrual by Fund [Summary] 
report. This report lists the various super amounts accrued for each fund based on the paycheques 
that have been recorded for your employees.

To display the 
Superannuation 
Accrual by Fund 
[Summary] report
1. Go to the Reports  
 menu and choose  
 Index to Reports.
2. Click the Payroll  
 tab and highlight  
 the Accrual by  
 Fund Summary  
 report.
3. Click Customise  
 to select the  
 fund(s) and the  
 date range that  
 you want to analyse.
4. Display the report.

 

Using reports to make informed business decisions
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Quick Tip: 

Save time by making your super contributions straight from your MYOB software. Subscribe to 
MYOB M-Powered superannuation, and for just $3 per quarter per employee you can make your 
contributions without having to write a single cheque. This service is available to MYOB Cover 
subscribers who are using MYOB Accounting Plus or MYOB Premier. To apply, find out more, or 
to read the M-Powered Services Product Disclosure Statement,  
visit www.myob.com.au/m-powered, or call 1300 555 111.

Transaction Journal reports

Don’t remember entering a particular transaction? Find out who 
recorded it and when
If multiple employees enter transactions in your company file, how can you determine who 
entered a particular transaction or when it was last edited? 

You can get this information easily with the Transaction Journal reports as you can choose to show 
the following information for each recorded transaction:
• The session date, which is the actual date that the transaction was recorded or last edited, 

based on the computer’s system date.
• The User ID, or login name, of the person who recorded or last edited the transaction.

To display a Transaction Journal report with the session date and User ID
1. Go to the Reports menu and choose Index to Reports.
2. Click the Accounts tab and highlight the General Journal report.
3. Click Customise.
4. Click the User IDs search button and select all User IDs in the list. Click OK.
5. Click the Source Journal drop-down button and choose which journal you want to look at, or 

select All.
6. Make any other required changes in the Advanced Filters tab to ensure that the transactions 

you want to analyse will appear in the report. (If you want to inquire about a single 
transaction, enter the transaction’s ID — invoice number, CR number, etc — in the From ID 
and To fields.)

7. Click the Report Fields tab and choose to include the User ID and Session Date field names.
8. Click Display.

Using reports to make informed business decisions

http://www.myob.com.au/m-powered
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Session reports

Want to review the transactions that you’ve entered and edited in 
your current session?
Each time you open a company file, a new session is started. You can use the Session report to 
see all transactions that have been created or edited in the current session. You may want to keep 
this report as a session-by-session record of all transactions that have been added or edited in your 
company file.

To display the Session report
1. Go to the Reports menu and choose Index to Reports.
2. Click the Accounts tab and highlight Session Report.
3. Click Customise if you want to show the User IDs or other report fields for each transaction.
4. Display the report.

Please note that this report cannot be reprinted once you close the company file. To avoid 
forgetting to print the report, you can choose to be prompted with the following message each 
time you close your company file:

To do this, go to the Setup menu, choose Preferences and click the Security tab. Mark the 
Prompt for a Session Report When Closing checkbox and you will receive a reminder to print 
the report whenever you close a session in which transactions have been entered or edited.

Using reports to make informed business decisions
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While your MYOB accounting software has the reports most frequently used by Australia’s small- 
to medium-sized businesses, your business may have specific reporting needs that require more 
advanced reporting capabilities. That’s where MYOB’s range of business intelligence solutions can 
help.

Create advanced reports with MYOB ReportWriter
MYOB ReportWriter is a powerful reporting tool that lets you create 
your own reports, perform flexible queries and interpret information 
with pivot tables and charts.

Whether you’re an advanced user of MYOB accounting software, an 
accountant or a consultant who works with clients that use MYOB 
software, MYOB ReportWriter is the most flexible reporting solution 
available. 

For more information about MYOB ReportWriter, please visit  
www.myob.com.au/products/reportwriter/ .

Interact with pre-defined reports using MYOB 
BusinessAnalyst

With MYOB BusinessAnalyst you can analyse your MYOB business 
information using pre-defined reports, charts and tables that have 
been specially designed for your business by MYOB Certified 
Consultants, have been downloaded from MYOB’s online solution 
store, or have been created using MYOB ReportWriter.

Find out more about MYOB BusinessAnalyst by visiting  
www.myob.com.au/products/businessanalyst/ .

Get powerful business management features and 
business intelligence in one system

Building on the business management power of MYOB 
Premier, MYOB Premier Enterprise also provides businesses 
with more advanced information management needs direct, 
network-based access to real time business intelligence.

With two MYOB BusinessAnalyst licences and eight business 
intelligence reports that analyse sales, inventory, gross profit, 
payroll, jobs and more, this system gives you clear insight 
into the key performance areas and drivers of your business.

For more information about MYOB Premier Enterprise, please 
visit www.myob.com.au/products/premier_enterprise/ .

® Registered to MYOB Technology Pty Ltd ABN 30 086 760 269. Microsoft is either a trademark or registered 
trademark of Microsoft Corporation in the United States and/or other countries. Adobe and Reader are 
either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other 
countries. QuickTime is a registered trademark of Apple Computer, Inc. 

Need advanced reporting?
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